
Y O U R  G U I D E  T O  A L L  T H I N G S  Y E A R B O O K



WHAT CAN THEY HELP YOU WITH?
REP
• Design ideas, including cover and theme
• Overall book and sales setup
• Curriculum and training
• Submitting pages
• Sample books
• Staff organization
• Pricing questions

CSA (CUSTOMER SERVICE)
• Answer production questions
• Deadline information
• Shipping information
• Turning on cover templates
• Person to call when rep is unavailable

TSA (TECH SUPPORT)
• Tech troubleshooting
• Errors uploading PSPA/PSPI file
• Support for InDesign plug-ins
• Answer questions about software 

WHO 
TO 
CALL

THEY’VE GOT YOUR BACK,  
SO ALWAYS HAVE THEIR 
INFO ON HAND.

YEARBOOK REPRESENTATIVE (REP)

Name:	

Email:	

Phone:	

CUSTOMER SERVICE ADVISER (CSA)

Name:	

Email:	

Phone:	800.255.6287

TECHNICAL SUPPORT ADVISER (TSA)

Submit a customer support form: 
herff.ly/techsupport

Phone:	877.362.7750

YEARBOOK ORDER CENTER

Phone:	866.287.3096

SCHOOL PHOTOGRAPHER

Company Name: 

Contact Name: 

Email:	

Phone:	

DETAILS TO KNOW BEFORE YOU CALL YOUR TSA OR CSA:

Your job number: 
Your school has a unique number to identify your files within the 
plant so they can find you easily. 

Operating system: 
What type of computers does your staff use?

Web browser: 
Which web browser do you use? They all operate differently, 
so knowing your preferred browser will help answer questions.
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MYHJYEARBOOK.COM 

LEARNYBK.COM

YEARBOOKDISCOVERIES.COM 
Start here and the world is your oyster. Well the yearbook 
world, at least. The top-level menu holds information about 
our programs, products and events. And your one-stop shop is 
For HJ Customers, where you’ll find teaching resources, sales 
support, inspiration and more!

MYHJYEARBOOK.COM
This is your portal to work on your book and gives easy access 
to deadlines, book sales and other critical information.
Access eDesign, eBusiness and other tools from here.

LEARNYBK.COM
Here’s a shortcut to online teaching resources. It serves as a 
companion to our 12-booklet How to Yearbook printed curriculum. 
From lesson plans to skill checks, you’ll find them here. Also, 
answer keys to all of the lessons and quizzes are available at  
herff.ly/answerkeys. Cool, huh? 

HJESHARE.COM
Also available as an app, eShare is an easy way for parents and 
students to share photos with you.

HJHELPCENTER.COM
The home for eDesign support, curriculum and lessons, video 
tutorials and PDF guides. You’ll reference this page often for all 
things eDesign and Canva. Plus, the tips from the pros are gold.
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YEARBOOKDISCOVERIES.COM > FOR HJ CUSTOMERS

MEET YOUR 
YBK BFFS THESE SITES 

ARE THE ONES 
TO KEEP CLOSE

MYHJYEARBOOK .COM LOGIN CREDENTIALS

My username: 

My password: 
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PL ANNING TOOLS
As you get organized and plan out 
your year, these are the items you’ll 
rely upon every day.

YBK Essentials: This booklet!  
It’s a great place to start

Ladders: Your Wall Ladder and  
Desk Ladder help you plan your book, 
page by page. Use them to sketch 
out assignments, group pages into 
deadlines, etc. 

Font Poster and Book: Start by 
using these to choose your fonts for 
the year, then teach your students 
about typography

Color Posters: More than just a 
collection of pretty hues, these are the 
colors loaded into eDesign with both 
CMYK ink formulas and Hex codes 
(web colors) to match. There’s one for 
each type of paper — gloss and matte 
— so you can see how the colors will 
reproduce in your book.

eShare Poster: Enlist help with your 
photo assignments with eShare. Anyone 
in your school can submit photos 
directly to you using this service.

EDUCATION AND INSPIRATION
The kit is full of great posters and 
booklets to help advisers teach their 
students the basics of yearbooking 
— photography, design, coverage, 
and more.

Photo resources: Teach the basics 
of composition with these student 
photography examples.

Mod Styles: Cover more students 
with modular layouts. These are 
great examples.

Square One: Teach the basics of 
graphic design with this poster and 
the other design resources found at 
LearnYBK.com.

SALES SUPPORT
We make book sales easy with 
online tools, like Sales Assist, 
Send and Sell, and in-person 
sales tools like our posters and 
flyers. Better still, we give you 
tools to guide students through 
the planning and execution of 
a full year of marketing and 
promotion for your yearbook.

All of these items are gathered 
into a mini sales kit. Check out the 
items in the plastic sleeve and then 
go to herff.ly/ybk-sales for more.

There’s always more: Need 
additional posters? Need an extra 
ladder? You got it! Many of these 
items are available at no charge. 
Just go to YearbookDiscoveries.
com/shop and click on the Kit 
Supplies link on the right side. 
You can order sales posters and 
flyers, as well as other helpful 
items from the kit.
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GET READY FOR YOUR BEST YEARBOOK EVER.

We strive to make yearbook easy and 

straightforward. While there’s a lot to do, 

we’ve gathered the most critical get-it-done 

information into this handy guide. Follow this, 

and you’ll be in great shape. 

We know yearbook programs come in all 

forms — clubs, small teams and large classes. 

Sometimes, it’s just one brave soul trying to put 

together the events of the year alongside all of 

those school pictures. As a yearbook adviser, 

you’ve got plenty of other important tasks to 

keep you busy. We get you, and we support your 

choice to do only as much as you choose. 

We’re here to help you break your tasks into 

bite-sized pieces and focus on making a fun, 

creative yearbook your school can be proud of. 
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WE’RE 
GLAD 

YOU’RE
 HERE.

The steps to make 
       your job easier…
1 .  T A K E  C A R E  O F  B U S I N E S S  p.4

•	 Produce a yearbook that kids love and 
parents want to buy

•	 Maintain a financially sound business

•	 Sell and/or promote books to as many 
people as possible

•	 Sell ads to celebrate student milestones

•	 Sell ads to local businesses so they can 
support your school community

2 .  S I M P L I F Y  T H E  P R O C E S S  p.8
•	 Produce a book on budget and on time

•	 Work with your representative and other 
Herff Jones support staff

•	 Handle the basics of yearbooking, like 
uploading portraits and photos, designing 
pages and submitting them when you’re ready. 

•	 There’s more support in our curriculum and 
online, but this is a great place to start.

3 .  N E X T - L E V E L  G O A L S  p.16
•	 If you have a club or a class, here are our 

suggestions for building a yearbook program 
that works for you and your school.

•	 Empower students to become leaders in the 
classroom and in the school

•	 Teach skills in communication, journalistic 
writing, graphic design, photography, business 
and more

•	 Allow students to grow in an area of interest 
and build their skill sets

•	 Support diversity and inclusion by making 
your staff one that students want to join

•	 Build relationships on your staff
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TAKE CARE OF BUSINESS
1.  PL AN YOUR SALES AND FINANCES: MA JOR TO-DOS!

 Refer to How to Yearbook: Selling Your Book and 
LearnYBK.com 

BUDGET

•	 Determine your sales goal. Is it to sell yearbooks for 
a profit as a fundraiser or keep prices down for your 
school community?

•	 Do you have a budget from the previous year?

BOOK SALES

•	 Do you sell books? If so, how many were sold  
last year? Account for books you give away, too. 

•	 Will you have one price all year or tiered pricing?

•	 Can you sell books at registration or  
back-to-school events?

•	 How will you promote your book?

•	 Do you need to be involved or does someone at 
school handle it?

AD SALES

•	 Will you sell ads to families, students and/or 
businesses?

•	 What price structure will you follow?

•	 How will you accomplish ad sales? Learn more about 
Online Ad Creation at herff.ly/online-ad-creation.

•	 Extra pages may be needed so discuss this with your 
yearbook rep.

HOW MANY BOOKS TO ORDER

•	 Be sure to include any pre-orders into your final copy 
count. Starting sales early in the year will help nail 
down how many you should order. 

•	 If school enrollment has changed significantly, it may 
mean changing the number of books ordered which 
will affect your budget.

2. GET YOUR BOOKKEEPING UNDERWAY
Once you get through all of the decisions for book and ad 
sales, you can set up eBusiness, the powerful business 
tracking software available only from Herff Jones. 

Go to MyHJyearbook.com and click on Set up > Set up 
Sales. Ask your rep or TSA for help as needed. 

•	 Set book and ad prices and sales schedules.

•	 Create packages and bundle personalization options. 

•	 Establish both in-school and online sales through 
YearbookOrderCenter.com. 

3. REQUEST YOUR STUDENT AND FACULT Y NAME LIST
A basic name list allows you to spell check names and use 
our email program Sales Assist to promote your book and 
send reminders.

Ask for a new list each year from your front office. Only two 
fields are required, but all are helpful: 

•	 REQUIRED: First and last names (in separate fields)

•	 REQUIRED: Grade 

•	 REQUIRED for Sales Assist: Parent email address

•	 Full mailing address (separate fields for address line 
one, two, city, state or province and ZIP or postal code)

•	 Homeroom or identifying class period

•	 Student ID or some unique identifier

•	 Student email address (for upper grades)

Also, you’ll want a list of faculty and staff members. 
Request the following fields:

•	 First and last names (in separate fields)

•	 Substitute STA for staff or FAC for faculty in the  
grade field

TROUBLESHOOTING:
If your front office questions your need for the student list, 
provide them with our FERPA and PIPEDA/FIPPA policies. 
These explain how Herff Jones is in compliance with laws 
related to using student information. Find them at herff.ly/
sales-assist-how-to.

 

04

UPLOAD YOUR NAME LIST
•	 Go to MyHJyearbook.com > Setup > Set up Sales.

•	 Then click the Name List tab on the left.

•	 Click Import to add your list of people or 
businesses.

IMPORT LIST TO eDESIGN
•	 In eDesign, click the Settings tab, under School & 

Order Information, choose Name List. 

•	 Check the box and tell eDesign to import it. 

Note: It may take up to 15 minutes for your name list to 
be available in eDesign after uploading to eBusiness.
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start strong for financial success
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4 . MAKE A YEAR-LONG MARKETING PL AN
Selling your yearbook is just as important as creating it. 
Use these resources and tips for promotion. 

•	 Posters and Flyers: We’ve provided samples of sales 
posters and flyers in this kit. Before you hang them, 
write your sale dates and other important information 
on them. 

•	 Social Media: Use your school or organization’s 
social media to promote book and ad sales. 
Graphics and templates are available for use at 
herff.ly/sellonsocials.

•	 Email Marketing: Email remains an effective way to 
engage with both parents and students. Learn more 
about our email-based yearbook sales campaign 
Sales Assist and eDesign’s own customized email 
campaign Send and Sell on p. 6.

Need more? Order as needed from herff.ly/ybk-shop. 

5. SELL THOSE BOOKS
•	 Participate in orientation or back-to-school events.  

Do whatever you can to include the yearbook as 
part of registration. Include it on forms, sell it at 
registration, have it included in fees.

•	 Create incentives for parents and students who 
purchase early. Tiered pricing — offering lower prices 
to early birds — makes parents feel like they are 
getting a good deal.

•	 Keep all the messaging positive. Make buyers feel 
great about their purchase.

•	 Use every communication channel available, 
including registration packets, emails, social media, 
morning announcements, automated phone calls 
and marketing materials in high-traffic areas.

SALES POSTERS (two designs available, found in the kit)

S E R I O U S L Y,  D O N’T  M I S S  O U T !

0 0 0 - 9 0 3  ©  Herff Jones LLC

SETTING UP TIERED PRICING 
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SALES ASSIST
Sales Assist is an email-based sales campaign designed 
to take the work out of reminding parents to purchase a 
yearbook. Following the best practices of online sales, 
reminders go to your list of parents a few times a month.

Once parents purchase a yearbook, they are automatically 
removed from the list. You may begin the campaign when 
you wish and stop it when you are ready. 

Parents buy online through YearbookOrderCenter.com, 
so you don’t have to handle money unless you choose 
to do in-school sales. And even then, the sales you enter 
in eBusiness are matched with the Sales Assist list, 
so parents no longer receive messages. Parents can 
also purchase by phone with the help of our customer 
service team.

Your MyHJYearbook.com portal gives you a real-time 
overview of how your sales are going, and eBusiness 
allows you to print reports to help you plan.

HOW IT WORKS

1.	 The campaign follows best practices for email sales. 
You can enroll when you are ready, and your list will 
be included in the next scheduled send. Un-enrolling 
when you’re done takes just one call. 

2.	 Once parents make a purchase, they are excluded 
from future emails. If you sell books in school and 
enter sales in eBusiness, those buyers will also 
be excluded from future emails. Make sure your 
eBusiness sales are updated regularly. 

 
3.	 Posters are included in the kit so you can 

coordinate your in-school marketing with the email 
campaign. If you run out of posters, order more 
from herff.ly/ybk-shop. 

 
4.	 Go to herff.ly/ybk-sales and check out all of the 

social media and web site graphics. Add them 
to your school’s web site, newsletters and other 
communications to parents.  
 

For more information, go to herff.ly/sales-assist.

HOW TO ENROLL
1.	 Get your name list with parents’ email 

addresses. (See p. 4 for more detail.)
2.	 Contact your rep to enroll and help you upload 

your list to eBusiness and eDesign. 

Keep your eBusiness records updated for best results. 

YEARBOOK ORDER CENTER
Never handle cash again with YearbookOrderCenter.com. 
It’s easy for parents to find your school and make a 
purchase. You can sell books and ads through the same 
site with Online Ad Creation, and eBusiness makes it 
easy to set up. Secure credit card sales and payment 
plans are available through PayPal. 

SEND AND SELL
In addition to Sales Assist, eDesign users can 
generate their own customized email campaigns. 
Using your uploaded name/email list, you can send 
reminders to parents who have not purchased 
a book. Take advantage of our pre-loaded email 
messages or make your own.  

Check out the video tutorials under the eDesign Help 
menu. Don’t forget to enter your in-school sales into 
eBusiness, before sending.

ADDITIONAL TOOLS TO HELP YOU SELL 
Customize your marketing and sales efforts to fit your 
school. While we have included samples in this kit, 
additional resources are available on herff.ly/ybk-shop.
 
Posters, banners and yard signs help with: 

•	 Book sales

•	 Senior ad sales

•	 Price increases

•	 Distribution day

•	 General yearbook awareness

•	 Last chance sales

SALES MADE EASY

FOLLOW THIS FORMULA TO FORMAT THE URL: 

yearbookordercenter.com/index.cfm/job/XXXX.  
Replace the XXXX with your job number. 
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ADDITIONS
PUT SOME BLING ON IT
Consider these enhancements to add value to your yearbook 
and to help generate income for your program. Contact your 
rep for ordering and pricing details.

PLASTIC JACKET
Hard-cover yearbooks 
stay protected and clean 
with these affordable 
plastic dust jackets.

AUTOGRAPH 
SUPPLEMENTS 
Plain or printed eight-page 
autograph supplements 
can be added with 
Kleenstick®  
self-adhesive tape.

NAME IMPRINT
A digital name imprint is a 
book personalization option, 
digitally printed on the cover. 
Printing student names on 
the cover leaves no question 
about whose book it is.

ENGRAVED  
NAME PLATES
Students can order metal 
plates engraved with their 
names and icons in one- or 
two-line configurations. 
These are not recommended 
for soft cover books.

For more information, visit herff.ly/ybk-add-ons. 

WORLD YEARBOOK
Designed for middle/high school readers, 
this 16-page supplement documents events 
that made history during the school year. 

OUR WORLD
A scaled-down version of World Yearbook 
intended for younger readers, the four-page 
Our World supplement features photos and 
captions about this year’s most interesting 
news stories.

If you purchase either of these for your entire 
order, you may choose where you want it to 
appear in your book (between signatures). 
If you don’t designate an insertion location, 
it will be added following the last page of 
your book. Also, either supplement can 
be purchased as a stand-alone item with 
Kleenstick® self-adhesive tape for easy, 
permanent placement the yearbooks.
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1.  FILL YOUR CALENDAR
Make the rounds and find all of the dates that affect your 
school and your yearbook production schedule.

SUBMISSION DEADLINE

Your deadline and ship date can be found in eDesign 
Settings > Deadlines. 

INCLUDE ON CALENDAR:

•	 Book sales events

•	 Picture day(s)

•	 Make-up picture day

•	 Club picture day(s)

•	 School activities (dances, rallies, assemblies)

•	 Theater/music/dance performances

•	 Club/organization events

•	 School holidays

IF YOU HAVE A YEARBOOK STAFF, ALSO INCLUDE:

•	 Staff work days/deadlines

•	 Cover design due date

2. MAKE IT AN OFFICIAL RECORD
A yearbook serves as the official record of the school 
year. Your goal should be to include every student, faculty 
and staff member in the book as many times as possible. 
Although every book is different, here are some items you 
may wish to include:

BASIC COVERAGE IDEAS:

•	 Individual portraits for students and faculty

•	 In-school activity photos 

•	 Club and organization photos

•	 Sports photos (if applicable)

ALSO CONSIDER:
•	 Table of contents listing on page 1 helps readers find 

topics easily

•	 Class group photos

•	 After-school activities

•	 School volunteers

•	 Special coverage of the graduating class (e.g., 5th 
graders moving on to middle school)

•	 Quotes from students and faculty/staff

•	 Fill in the blank features, such as “My favorite 
memory,” “The best part about school is...”

•	 Autograph page(s) 

•	 Index: a list all student names and any page numbers 
they are pictured on

SIMPLIFY THE PROCESS
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WHAT IF I  DON’T HAVE A YEARBOOK STAFF?
•	 Recruit parents or other school staff 

members to help you.

•	 Request assistance from teachers or 
counselors to help proof portrait pages.  
Their input on the correct spelling of names 
and identifying missing students is essential.

•	 Use Google forms to get great quotes from 
teachers or to conduct surveys with help 
from  teachers.

•	 Consider holding a photo contest to 
encourage student submissions.

•	 Feature student artwork or poetry.

•	 Use eShare to ask for photos.  
(See poster in this kit.)

•	 Consider forming a yearbook committee 
of parent helpers.

WHAT IF YEARBOOK IS A CLUB?
Yearbook clubs can be every bit as productive 
as yearbook classes. However, advisers have to 
motivate students with a force more powerful 
than grades. If you have a small staff, a club can 
supplement the staff’s work or allow students  
with packed schedules to get involved. 

SUGGESTIONS:

•	 Attend a workshop, summer camp or hold 
boot camp training sessions for staffers.

•	 Create an incentive system for staffers so they 
can earn a free book, a free ad or perhaps a 
discount on attending a workshop.

•	 Plan work nights when a deadline is looming. 
Have students bring part of a meal. Taco night, 
ice cream sundae bars, baked potato bars are 
all fun and simple.

•	 Consider offering membership in organizations, 
such as Quill and Scroll for high school, as a 
benefit to successful club participation.
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3. BUILD A L ADDER
In yearbook, the ladder is simply a chart that helps you 
plan what will go on each page so you can track pages and 
spreads as they are completed and finalized. 

SET UP YOUR LADDER IN eDESIGN

1.	Log in to eDesign: Go to MyHJYearbook.com.  
Click on the Design menu and choose Pages.  
You’ll see all the spreads in your book with thumbnail 
previews and information about each page.

2.	Create topics and assign to pages: You’ll want to 
create topic tags for each page in your book. You can 
use these same topics to tag photos to save time. See 
the tutorial in eDesign Help on creating topic tags.

3.	Assign topics to pages: See the tutorial in eDesign 
Help on setting up the ladder.

4.	Assign deadlines and staff members: If you are 
working with a staff, assign each staffer to specific 
pages in the ladder. See the tutorial in eDesign Help 
on setting up the ladder.

4 . CREATE YOUR COVER 
Making your yearbook cover is exciting, as it is the first 
thing the reader will see when the book arrives.

1.	Keep it nice and simple: Use a predesigned cover. 
These covers are available for you to take your pick, 
share your book title or school name and let us do the 
work for you. 

To make your selection, head to your eDesign 
Settings menu. Click School & Order Information 
and Cover Setup. From there, you can check off 
Predesigned Cover, use the dropdown menu and add 
your text. 

2.	Get creative with a Book Style template. Find 
and add a cover (and corresponding page templates, 
mods and art!) in the eDesign Book Styles catalog, 
turn on the Custom Cover template, then you’re 
ready to make the Book Style your own. 

To turn on the Custom Cover template, head to 
your eDesign Settings menu. Click School & Order 
Information and Cover Setup. From there, you can 
click Custom Cover. 

3.	Go custom! You can design from scratch your own 
cover in eDesign. Access graphics in the eDesign 
Catalog or upload your own student-submitted 
artwork to incorporate into your design. Make sure 
you have the Custom Cover template turned on 
following the instructions above. 

BASIC BOOK ELEMENTS:
•	 Cover: Theme, book title and year.

•	 Spine: As space allows, school name, city and state. 
Then, year and volume. Then, book name and theme,  
if it fits.

5. DESIGN MADE EASY
Follow the tips on p. 10–11 of this booklet.

getting organized early helps smooth the journey
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WALL LADDER is included in kit to help you plan.

121      

122      123      

124      

109      

110      111      

112      113      

114      115      

116      117      

118      119      

120      

97      

98      99      

100      101      

102      103      

104      105      

106      107      

108      

85      

86      87      

88      89      

90      91      

92      93      

94      95      

96      

73      

74      75      

76      77      

78      79      

80      81      

82      83      

84      

61      

62      63      

64      65      

66      67      

68      69      

70      71      

72      

49      

50      51      

52      53      

54      55      

56      57      

58      59      

60      

37      

38      39      

40      41      

42      43      

44      45      

46      47      

48      

25      

26      27      

28      29      

30      31      

32      33      

34      35      

36      

13      

14      15      

16     17      

18      19      

20      21      

22      23      

24      

1      

2      3      

4      5      

6      7      

8      9      

10      11      

12      

Use this page ladder to plan your 

yearbook. Write the content for each 

page in the space provided and check 

the box when you complete the page. 

You’ll thank yourself later.

You’ll notice the pages in this 

ladder alternate colors in four-page 

increments. Because of the way your 

book is bound, when you change the 

number of pages in your book you must 

add or remove four pages at a time. 

Do a happy dance when you 

submit your pages.  

Your friends in the plant will, too!

Printed in USA0714HLH©

PAGE
ladder

1      

Title Page
School Info

2      

Dedication 
Page

3      

Field Day

4      

Variety 
Show

5      

Trip to  
the Zoo

0 0 0 - 4 0 8  ©  2 0 2 0  H e r f f  J o n e s ,  L L C
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STEP 1:  DECIDE WHICH L AYOUTS WORK BEST FOR YOU
We offer a variety of predesigned layouts for both covers and inside pages. 
Activate them in the eDesign Catalog, and drag and drop them on pages. 
Then you can modify them any way you’d like. You may also create your 
own custom layouts for a new look.

•	 Book Styles — For advisers who don’t want to start with a blank 
page, Book Styles include everything needed to build a beautiful 
yearbook, including covers, templates, carefully matched fonts, 
color palettes, art and mods. Activate the Book Style of your choice 
through the Catalog. 

•	 Square OneTM — Our system for teaching graphic design basics, 
Square OneTM gives you all the templates and mods you need. 
Begin on paper using our layout planning resources or on screen. 
Go to the Design section of LearnYBK.com or ask your rep for 
more information about Square One.TM 

•	 More Templates — The eDesign Catalog holds a wide assortment 
of additional templates for building a yearbook that suits your 
school. Load trendy topics or interrupter spreads and tweak them to 
make them your own.

STEP 2: ACTIVATE THE COLORS YOU WANT TO USE
Don’t pick colors based on how they look on screen nor based on how 
they look when printed from your desktop printer. These do not accurately 
show what colors will look like when printed on a printing press. 

Instead, look at the colors on the color poster. Make sure to refer to 
the poster that matches the paper you plan to use (gloss or matte). 
Each color has a CMYK code that matches colors in eDesign (for 
example, C=0 M=63 Y=73 K=0).

  C is cyan     M is magenta     Y is yellow     K is black 

Make note of the CMYK numbers and activate those colors in Book 
Setup in eDesign. Watch Activating Colors in eDesign Help for more. When 
you add colors in eDesign, you can name them for easy reference.

STEP 3: SELECT FONTS AND CREATE ST YLES
Start with the Font Poster found in this kit. Limit the number of fonts you 
activate for a better eDesign experience and a more cohesive look to your 
book. Activate only fonts you want accessible to your staff on every page. 

Under the Settings tab, click Design Styles to find Fonts. If you activated a 
Book Style or added templates to your library, you can use the fonts as-is 
or you can modify them. 

You’re not required to use character styles, but they can be an easy way 
to apply consistent text formatting in your book.

EXAMPLE: 	 AHJ Chantilly Bold 	 24 pt.	 CMYK = 43, 12, 17, 87

	 Headlines	 font 	 pt size 	 color 

	 Subheads	 font 	 pt size 	 color 

	 Copy	 font 	 pt size 	 color 

	 Captions 	 font 	 pt size 	 color 

COLOR POSTER found in the kit. 

eDESIGN CATALOG is home to templates, art and 
mods. 

ONLINE HELP
eDESIGN HELP:
MYHJYEARBOOK.COM > LEARN

•	 Curriculum Videos and Worksheets

•	 Video Tutorials

•	 PDF Guides and Tip Sheets

GEAR UP FOR eDESIGN



11

STEP 4 : IF DESIRED, PL ACE ART ON PAGES
The Art Library is packed full of graphics available to be used with your 
book. Some are matched with the Book Styles covers and templates, 
and other pieces are grouped by topic or go with a cover-only design. 
Browse the tabs to find what interests you. 

You can also access an expansive variety of searchable and customizable 
art and backgrounds in Canva. After customizing it, you can save it from 
Canva directly into your Art Library. There are videos in eDesign Help that 
show how to activate art in the Library.

STEP 5: GET TO WORK!
You can find eDesign tutorials and guides to support each step of 
learning and using eDesign. Access the eDesign Help Center in a variety 
of ways. 

•	 Bookmark HJHelpCenter.com

•	 MyHJYearbook.com > Learn > eDesign Help

•	 In eDesign, click the Help menu to search or click out to the Help 
Center

eDESIGN CURRICULUM is a set of eight lessons designed to give 
students a strong understanding of eDesign and familiarize them with 
many of eDesign’s great features 

VIDEO TUTORIALS LIBRARY provides access to all the video tutorials 
that cover eDesign’s powerful features. Most of the “all staff” tutorials are 
contained in the eDesign Curriculum.

PDF GUIDES are available to cover design tips, Canva and strategies 
for how-to submit your yearbook. 

SO MANY RESOURCES
herff.ly/ybk-resources

•	 Head to YearbookDiscoveries.com > 
For HJ Customers, where you’ll find 
teaching resources, sales support, 
inspiration and more!

herff.ly/my-ybk-guide
•	 This dedicated space is designed for 

elementary or smaller yearbook 
programs and provides directions and 
support tools specifically geared for 
those books.

FONT BOOK
AVA IL A BL E ONL INE AT herff.ly/font-booklet

•	 More than 500 fonts

•	 Explanation of types of fonts and 
tips for designing with fonts
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THE EDESIGN WORKFLOW FOR PAGES 
A page in eDesign passes through a few stages before it is 
submitted. These stages help you monitor progress and track 
what’s been done to each page.

 
No edits have been made. The page moves to the 
Edited stage after changes are made and saved on 
the page. Only the people assigned to the page or the 
adviser can edit a page. 

A page remains in this stage while the assigned staff 
members are working. When the page is complete, 
click the Pre-Submit link. 

In this stage, a page can only be unlocked by 
the adviser. Pre-Submit is the final step before 
submitting to the plant.

Always generate a high-res PDF of the 
final version of each page and carefully 
review it before submission. 

The PDF represents what will print, so be 
sure it appears as expected. This is your 
proof before submission.

The adviser has submitted the book to Herff Jones, 
and the page has begun its process at the plant.

WHEN IT  
NEEDS MORE WORK:  

Use the buttons in the 
ladder to move a page back 
to Edited to allow the staff 
member to edit it again.

UNEDITED

EDITED

PRE-SUBMIT

SUBMITTED

UNDERSTANDING PREFLIGHT 
Preflight Check in eDesign helps you in the proofing 
process by alerting you to potential issues. To run 
Preflight, go to the File menu when a page is open and 
choose Show Preflight Check. 

 

In Preflight Check, alerts appear in the vertical bars to 
the outside of each page. If you click on the alert, eDesign 
selects the item on the page that the alert references. If 
you hover over an alert, eDesign gives a brief description 
of the issue. The different alert types are described below. 

Preflight issues definitions: 

•	 Text across the gutter: Indicates a text frame 
that touches or crosses onto the adjoining page. 
Make sure no text will be lost in the gutter when the 
book is bound.

•	 Bleed object: Identifies an object that is very near 
the edge of the page but that does not fully bleed off 
the edge. Bleed elements must extend to the outside 
edge of the 1-pica red border around the spread.

•	 Image not filling frame: Indicates an image that 
does not completely fill the photo frame if the frame 
has a stroke applied.

•	 Low-resolution image: Appears when a photo’s 
resolution is too low for the highest print quality, 
indicating the photo will be fuzzy. A resolution 
warning also appears on the image.

•	 Lorem Ipsum text: Identifies placeholder text 
— starting with Lorem Ipsum — that has not been 
replaced with actual text. 

PROOF. PREFLIGHT. SUBMIT.

	� Does a school administrator need to review all of the 
pages before the book can be submitted?

	� No photos have DPI (resolution) warnings on them.

	� Photos marked as “in use” are not duplicated.

	� You’ve used the appropriate title for all faculty, staff 
and administrators.

	� The entire book has been spell checked.

	� Pictures that bleed off the page extend outside the 
thick pink border.

	� No text crosses the gutter.

	� Images that cross the gutter aren’t losing vital 
elements (i.e. missing noses because picture of head 
is centered exactly on the gutter).

Find more checklists at herff.ly/ybk-checklists.

BEFORE YOU SUBMIT
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SUBMIT TING YOUR BOOK
SUBMIT YOUR ORDER

1.	 When all your pages have been proofed and are in 
the Pre-Submit stage, you’ll see the Submit Book 
button active at the top of the ladder. 

2.	 Click the Submit Book* button.

3.	 Walk through the submission wizard to transmit 
your pages and order information to the plant. You 
will be able to review the current order and make 
changes to these specifications. 

4.	 Add any personalization or accessory orders. 
See p. 7 for all additional options. If you have made 
changes that will affect the pricing of your book, a 
pop up will appear to warn you of these changes.

5.	 Review your order details for a summary of your 
changes — along with changing your paper stock 
(if necessary) and confirming your school and 
contact information.

6.	 Select Proceed to Book Submission.

7.	 Click Submit Book to officially submit to the plant 
for production.

PLEASE NOTE: Any changes made previously or at time 
of submission may impact pricing if they differ from 
your initial order. Be sure to contact your rep with any 
questions about pricing.

*If the Submit Book button is grayed out and doesn’t work, 
this means that there are unanswered questions regarding 
the cover. Go to Settings, then click on School & Order 
Information tab on the left side of the page. Then select 
Cover Setup. See p. 9 for creating your cover. 

SHIP DATE

Your ship date (when the book is complete and ships 
from the plant) is based on when you submit the book. 
To determine when to submit so you get the ship date 
you need, contact your rep or Customer Service Adviser.

FILTER YOUR L ADDER
The Filter menu in the Book module allows you to filter your pages by 
their production states. Also helpful is the Show My Pages filter that 
allows staff members to see only the pages assigned to them.

SAVE IT FORWARD
After you submit your final pages, you’ll be given the option to transfer 
templates and settings to the next year’s book. You also have the option 
to use Save it Forward to transfer other settings such as your list of 
topics, ladder designations, staff, etc. Refer to eDesign Help for more 
information.

ALWAYS REVIEW A HIGH-RES PDF  
You generate PDFs from the File menu in 
Page Design and from the Export menu 
in the ladder. Use a low-resolution PDF for 
non-final quick proofs. A high-resolution 
PDF should be reviewed by the adviser 
before submission. Viewing a high-res PDF 
at 300 percent gives a good representation 
of the quality of images, etc. Be sure you’re 
happy with the appearance of the high-
resolution PDF. The PDF represents how 
the page will print. 

THE IMPORTANCE OF PROOFING
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Portraits are incredibly important, so set aside 
plenty of time to ensure all portraits are included 
in the right grade or class and that all names are 
spelled correctly.

 Refer to How to Yearbook: People and Index 
and LearnYBK.com for more help, then 
check out the tutorials in eDesign help.

STEP 1: OBTAIN THE PORTRAIT FILE
Obtain the PSPI file from your school 
photographer. Use the one made specifically for 
yearbook. Some photography companies send a 
CD, and others send a link to download the files.

STEP 2: UPLOAD THE PORTRAIT FILES
In the Portraits section of the eDesign Library, go 
to the Import/Export menu and choose Import 
PSPI File to upload school photographer and 
eShare submitted portraits. 

If a student or parent submits an additional 
portrait, it can be individually uploaded as needed.
Please note these do not upload with name and 
grade information.

STEP 3: FLOW THE PORTRAITS
Use eDesign’s Portrait Flow to place portraits 
and names onto the pages. It flows them in 
alphabetical order in groups you designate (by 
teacher or by grade). Do not put empty portrait 
frames onto pages first. eDesign does it for you. 

STEP 4: PROOF THE PORTRAIT PAGES
Either print the portrait pages or email low-res 
PDFs to teachers or others able to assist: 

•	 Any misspelled names?

•	 Any missing portraits? 

•	 Any portraits with the wrong names?

•	 Any student listed in the wrong grade/class?

There is also an option to print directory proofs of 
your portraits. See eDesign Help for more info. 

STEP 5: CHANGES IN PORTRAIT LIBRARY
After proofing, edit the portrait data in the 
Portraits Library, NOT on the pages. 

Use a consistent format for grades and teacher 
names. Teacher names are only needed if you plan 
to group students by teacher in the book.

STEP 6: RE-FLOW THE PORTRAITS
A red alert will appear next to any group in Portrait 
Flow that needs to be re-flowed. Click Edit beside 
the portrait flow you need to re-flow. 

Portrait Flow remembers all the settings from 
when the section was last flowed. Re-flowing the 
section will put the changes you made on the 
pages. Changes made in the Library will not go 
onto the pages until you re-flow.

PORTRAIT FLOW WIZARD
The eDesign Portrait Flow wizard walks you through the process 
of placing portraits and names on pages. Select a page in the 
ladder, then go to Edit > Portrait Flow to launch.

You can now flow grades, senior quotes or a larger teacher photo.

NAME CHANGES IN PORTRAIT LIBRARY
Always make changes to names and grades in the Portrait 
Library. Then re-flow the section. If you make changes to names 
on pages, the changes will be lost if you re-flow.

Professional School Photographers International (PSPI) is 
an organization of photographers who set the standards 
for how school portraits should be shot and processed for 
yearbook publishing.
 
It should always be setup with the following: 

1.	 Index file should be saved as a text (tab delimited) file 
and MUST be named “Index.txt” to work properly.

It should contain these six columns: 
A: Disc/Volume Name
B: Folder Name
C: Image Name (including extension)
D: Grade
E: Last Name
F: First Name
G: Teacher Name

2.	 The folders containing images, along with the index file, 
need to be in a folder together and zipped. 

3.	 The portrait image files should be in RGB color space, 
JPG file format. 640x800 and 300dpi. 

UNDERSTANDING THE PSPI FILE
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THE PORTRAITS PROCESS
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STEP 1:  IDENTIF Y THE TOTAL NUMBER OF PAGES IN YOUR BOOK :     pages 

STEP 2: DETERMINE THE TOTAL NUMBER OF PORTRAIT PAGES YOU NEED

ELEMENTARY SCHOOL 

  # of pages for homerooms or classes 

+    # of portrait pages for other teachers, staff and administration

=    TOTAL # OF PAGES NEEDED FOR PORTRAITS

MIDDLE OR HIGH SCHOOL

# of ninth/sixth graders 	  divided by # portraits per page =    pages

# of 10th/seventh graders 	  divided by # portraits per page =    pages
 
# of 11th/eighth graders 	  divided by # portraits per page =    pages

# of 12th graders 	  divided by # portraits per page =    pages 
  
# of faculty/staff 	  divided by # portraits per page =    pages

                                     TOTAL # OF PAGES NEEDED FOR PORTRAITS  =   pages

STEP 3: CALCUL ATE HOW MANY YOU HAVE LEF T FOR OTHER TOPICS

  Total pages in your book 

–    Total number of portrait pages

=    PAGES REMAINING FOR ADDITIONAL CONTENT

                          Ex. 64 pages total – 22 portrait pages =  42 pages for additional content

STEP 4 : PL AN FOR IMPORTANT EVENTS
Make a list of all important events you’d like to include, the date they’ll happen, and the number of space 
you want to devote to them.

DATE	 EVENT		  AMOUNT OF SPACE IN BOOK

Ex. 8/24                  	 First day of school                               		   1/2 page

Ex. 9/15   	 Fall festival                     		  2 pages

	 	      

	 	      

	 	      

	 	      

 Refer to How to Yearbook: Covering Your School and LearnYBK.com.
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NEXT-LEVEL GOALS
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TAKE TIME TO TEACH
Use the first weeks of the school year to establish the skills 
and routines to empower students to do the heavy lifting 
in yearbook. There’s no right or wrong way to teach. Plus, 
there’s just so much out there! 

Teaching resources can be found online at LearnYBK.
com, with downloadable answer keys, found at: herff.ly/
answerkeys. Order the printed How to Yearbook printed 
curriculum at herff.ly/ybk-shop.

TACKLE A THEME AND CONCEPT
Think of a theme as a storyline of the year. Themes provide 
visual and verbal unity for yearbooks. While they might not 
be obvious to every reader, a book with a theme presents 
a much better impression than a book without a theme. 
For theme development resources, see How to Yearbook: 
Theme and Voice.

A GOOD THEME IS:
RECOGNIZABLE: Does it make sense as a framework for 
the whole book?

REFRESHING: Is it contemporary and different?

REPEATABLE: Can it easily appear on each theme spread 
without getting old? Can you come up with spin-off ideas?

REALISTIC: Is it appropriate to the students at your 
school this year? Does it relate to these students and this 
community?

RELEVANT: Is it relevant to each section of the book? Can 
the theme introduce each section without being forced? In 
20 years, will this theme seem relevant to the year in which 
it was produced?

If your theme is a storyline, think about what story you will 
tell. Here are some popular categories:

•	 We have a great reputation or legacy.

•	 We celebrate the individual as part of a larger group.

•	 We celebrate our group identity.

•	 Location. Location. Location.

•	 We’re all connected.

•	 Live in the moment.

MAKE YEARBOOK A CULTURE
Yearbook is an opportunity to find students who have an 
array of interests and dreams, and teach them the skills to 
pursue any career they want. If you make the experience 
fun and rewarding, students will not only want to join, but 
return for more of this crazy thing we call yearbook.

ESTABLISH STAFF TRADITIONS
Celebrate birthdays and holidays, recognize good work 
with simple awards. Work nights = food fests.

BE INCLUSIVE
Make room for visual students and verbal students, for 
organized kids who can handle the business side and 
those who just want to interview people. 

Recruit vibrant personalities and the kids sitting quietly 
in the corner. Make yearbook that much more special 
because it’s made for everyone.

EMPOWER YOUR LEADERS
Put your editors in charge. Start each week or class/club 
session with a quick meeting. Editors lead, asking each 
department or member of the staff to provide their status 
on assignments. Adjustments are made while everyone is 
on-board, and then work begins.

Assign returning staffers a topic they know well. Allow 
one to two days to prepare a full class lesson. Then, have 
them teach the class. Everyone should take notes and 
ask questions. This can develop teaching/mentoring 
relationships for new staffers.

CREATE FUTURE LEADERS
You’ll find everything you need to help promote your 
yearbook program to potential staffers, and even to 
administrators, at herff.ly/ybk-recruiting.
Every student helping with your yearbook should be 
educated on professional behavior when in yearbook 
mode. They need to understand that they represent 
your program. 

Those students, plus every teacher in the building, the 
counselors and the administrators should all be able to 
list the skills yearbook offers:

•	 Interpersonal and sales communication

•	 Interviewing

•	 Journalistic writing

•	 Graphic design

•	 Photography

•	 Specialized knowledge of the printing industry

•	 Leadership and team building

•	 Technology

•	 Time management and meeting deadlines 
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if you have a staff, put them to work

USE YOUR RESOURCES
START HERE: The printed curriculum and LearnYBK.
com include a scope and sequence document, which 
provides a sketch of how to teach yearbook skills. If you’re 
looking for something a little less intense, check out the 
quick-start guides at herff.ly/quickstart.

PRINTED CURRICULUM: How to Yearbook is a 
comprehensive guide to advising. From developing 
a theme to selling books, it’s packed with yearbook 
goodness. Written for both advisers and staffers, this 
12-section set is ready for you to customize for your 
classroom. Available through your rep or for order on 
herff.ly/ybk-shop. 

ONLINE RESOURCES: Start at herff.ly/ybk-resources 
for the complete yearbook toolbox. Find classroom tools, 
marketing and sales graphics and more. Plus, answer keys 
are available at herff.ly/answerkeys. All ready for you!

VIDEO TUTORIALS: Access our ever-growing library of 
video tutorials through the Learn menu of MyHJYearbook.
com or the eDesign help button. 

ADVISER ASSISTANCE EMAILS: Make sure you’re 
getting these monthly emails from us. They’re filled with 
timely tips and tricks. We’re making sure you’ll never 
yearbook alone. 

WORKSHOPS: These are a great way for students to 
begin planning their book during their downtime.  
Go to herff.ly/ybk-events for details on local, regional 
and national workshops. And check out our virtual 
summer workshops 

MEET PORTFOLIO: THE BEST OF HERFF JONES
This annual publication compiles all of our 
best examples — from covers and individual 
spreads to overviews of some of the top books 
being produced.

Our family of staffs, spanning our international 
network, is known for innovation and for 
leading the way to produce new kinds of 
thriving publications suitable to any school and 
any budget. Check out the online version at 
herff.ly/portfolio.

STILL NOT SURE WHERE TO START ?
We have resources curated especially 
for advisers who have just stepped into 
the world of yearbook. There’s so much 
to learn — and teach, if you have staffers 
— so these resources are meant for both 
uses. 

Visit herff.ly/newadviser. Check out the 
slideshows to learn the yearbook basics 
and then teach them to your students in 
the first weeks of the school year. You’ve 
got this!

Follow us on social media @HJYearbook, 
and make sure you are receiving our Adviser 
Assistance emails the first Wednesday of 
each month. 

Make Herff Jones Yearbooks yearbook@
yb.herffjones.com an approved sender in 
your email settings. Reach out to your rep if 
you ever need additional support.

SURVIVE THE FIRST MONTH

PAY ATTENTION TO THESE EARLY ON:

	� REFLECTIVE OF THE SCHOOL: Don’t forget to get 
activities calendars and sports schedules to help 
map out complete coverage for the year. School and 
district calendars can also help plan around school 
holidays and any special events.

	� BUDGET REVIEW: Money matters are an integral 
part of the yearbook experience for students. 
Everyone on staff should have a clear understanding 
of how much it costs to run the yearbook program 
and how funds are generated.

	� BOOK AND AD SALES PROMOTION: Be sure 
students and parents know when they may buy the 
yearbook and ads/dedications, along with where 
and how much. 

	� GATHER SCHOOL LISTS: Student enrollment 
names and schedules will be useful for name 
checking and also with locating students for 
interviews or other communication. Start strong 
with this info in hand.

Find more checklists at herff.ly/ybk-checklists.
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MAKE SNAP DECISIONS

eSHARE APP The eShare app is 
available in the App Store or the 
Google Play store.

IMAGE QUALITY 
The triangle means your photo will be fuzzy at the size it is on the 
page. Either choose a different photo or make the photo smaller.

Photos create the biggest impact in your yearbook,  
so you’ll want to collect the best. 

 Refer to How to Yearbook: Cameras and Photos and 
LearnYBK.com for more help.

PHOTOGRAPHY TIPS
DO set your camera’s image size to the appropriate settings.

•	 If you set it higher, your image will upload slowly, but you can 
make photos really large in the book.

•	 If you set it lower, your image will upload quickly, but you 
can’t enlarge photos much in the book.

DO make high-res PDFs of your spreads in eDesign and zoom in 
to 300 percent to see image quality.

DON’T take images directly off the internet or from someone’s 
social media site. There could be copyright and resolution issues.

DON’T ignore DPI warnings in eDesign on low-resolution images. 
Either make the image smaller on the page or choose another 
image for that spot instead.

CROWDSOURCE PHOTOS WITH eSHARE
Promote eShare at HJeShare.com or the HJ eShare app through 
Apple and Android, and make requests in the school newsletter, 
via homeroom teachers, email or a note sent home with students. 

You are in complete control of what’s included in the yearbook, 
and you can customize submission deadlines and accompanying 
guidelines. Fully integrated into eDesign, you can transfer 
submitted candid photos or even portraits right into your eDesign 
photo library, adding tags and information as you go. 

To set up eShare, go to MyHJyearbook.com > Transfer > 
Get Images from eShare > Preferences.

	� Photos show action, reaction, motion, or 
emotion.

	� All photos are clear and sharp, not fuzzy 
or blurred. 

	� All photos have a clear focal point of 
interest.

	� Photos follow rule of thirds and cropped 
to the focal point.

	� No photos show only tops of heads and/
or backs.

	� Action in photographs faces center of 
the spread.

	� No individual is featured too many times.

	� Avoid posed shots (excluding portraits 
and group photographs) of students 
“mugging” or “hamming it up” for the 
camera. 

	� Any photos with DPI warnings have 
either been replaced, resized or checked 
on a high-res PDF.

	� No heads in the gutter. (Photos that 
cross the gutter do not split faces.) 

Find more checklists at herff.ly/ybk-checklists.

CHOOSING THE BEST PHOTOGRAPHY

18
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ORGANIZING YOUR IMAGES
Topic tags in eDesign are “buckets” for all photo categories and 
can be used in multiple ways to save time and keep you organized.

Advisers and editors can create topics in the Topics panel in the 
Library, in the Topics panel in the Ladder and in the Topics area in 
Book Setup.

TOPICS HELP YOU BUILD YOUR LADDER
Topics are applied to pages in the ladder to designate the content 
of each page. Just create the topic tag (if it doesn’t exist) and 
apply it to the correct pages in the ladder.

TOPICS KEEP YOUR IMAGES ORGANIZED
Topics are like folders — but they’re better. Images can be tagged 
with more than one topic. That way a great image will appear 
for potential use on multiple pages (making the best use of your 
photos). The In Use indicator appears if an image is already used 
elsewhere so you can avoid duplicates. 

SHOWING YOUR TAGGED IMAGES
You can easily show the images tagged with 
a topic much like you open a folder on your 
computer. 

In the Library, go to the Topics tag panel and 
click the filter icon beside the topic to show 
only those images. 

THREE KINDS OF TAGS
Topic tags are essential for good organization, and you can add 
names and keywords for additional benefits:

1.	 TOPICS: Tag images with the same page topics you used to 
build your ladder.

2.	NAMES: Tag images with names in the Name List you 
import into eDesign.

3.	KEYWORDS: Tag images with extra information that might 
be helpful to you, especially more specific information (the 
event, the date, the opponent, etc.)

THREE WAYS TO UPLOAD IMAGES TO THE LIBRARY
Before uploading, decide which photos you’re most likely to use.  
It is best to limit uploads to the best photos.

1.	 IMPORT IMAGES: In the Candids section of the Library, 
go to the Import/Export menu and choose Import from My 
Device or Import from Google Drive. You can upload up to 
100 images in a batch.

2.	DRAG AND DROP:  In the Candids section of the Library, 
drag and drop images from your computer on the Library 
area. These images will begin uploading. You can upload up 
to 100 images in a batch.

3.	WHILE EDITING A PAGE:  When using the Candids section 
of the Library panel in Page Design, click the Add New 
option to upload images. You can also drag and drop up to 
100 images right to the Candids library panel while working 
on a spread. If the Library panel is filtered by Topic when 
uploading, that Topic will automatically be assigned to the 
newly imported images.

TOPICS: Ms. Smith’s Second Grade
NAMES: May Reddle, CeCe Smith
KEYWORDS: Oak Hill Farm field trip

GOOGLE INTEGRATION
You can upload from your computer or from your 
Google Drive. Go to eDesign Library >  
Import/Export > Import from My Device or 
Import from Google Drive.

IMAGES LIBRARY
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It’s more than just a list of topics to teach.  
How to Yearbook is a comprehensive guide to 
advising. From developing a theme to selling books, 
it’s packed with yearbook goodness. Written for 
both advisers and staffers, this 12-section set is 
ready for you to customize for your classroom. 

Extended resources can be found online at 
LearnYBK.com, with downloadable answer keys, 
found at: herff.ly/answerkeys.

Available through your rep or for order on 
herff.ly/ybk-shop.

S E C T I O N  O N E

WELCOME TO HERFF JONES
Start the year with a strong foundation.

S E C T I O N  T W O

TE AMS AND LE ADERS
Cultivate the community that works.

S E C T I O N  T H R E E

INTRO TO JOURNALISM
An overview of the basics.

S E C T I O N  F O U R

THEME AND VOICE
Unite the verbal and visual.

S E C T I O N  F I V E

COVERING YOUR SCHOOL
They all have stories to tell.

S E C T I O N  S I X

REPORTING AND WRITING
Use their words, not yours.

S E C T I O N  S E V E N

CAMER AS AND PHOTOS
Create a photo worthy of the spotlight.

S E C T I O N  E I G H T

L AYOUT AND DESIGN
Make it all fit together.

S E C T I O N  N I N E

TOOLS OF THE TR ADE
Online-only guides to eDesign and InDesign.

S E C T I O N  1 0

PEOPLE AND INDE X
Complete the history book.

S E C T I O N  1 1

SELLING YOUR BOOK
The book only matters if people buy it.

S E C T I O N  1 2

WORDS TO KNOW
Glossary and curriculum alignment.

HOW
TO 
YEARBOOK

EXPLORE OUR 
COMPREHENSIVE 
CURRICULUM
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NOTE OF CAUTION

DIGITAL  
DISPLAY

If you are using Canva to create graphics 

for your yearbook, we want you to be aware 

that the colors of those graphics are unlikely 

to be a perfect match to colors you are 

creating in eDesign or InDesign. This is not a 

shortcoming of any of the programs, rather 

it is the reality of crossing three different 

methods of presenting color.

KEYBOARD SHORTCUTS
They’re not required, but they sure make the work go 

faster. Keyboard shortcuts keep your hands on the 

keyboard so you can fly through a design.

CMYK 
How printers blend 
colors for printing 
with ink on paper

RGB 
How screens  
display color

HEXIDECIMAL  
(also called HTML 
or Hex codes) How 

web pages deal with 
and label colors

#cbc293

On the color poster, found in the kit, we provided both 
the CMYK and Hex values to help you work with Canva. 

The CMYK values can be used in eDesign, but Canva 
only allows colors to be specified with Hex codes. You 
can achieve a very close match using the CMYK colors 
and Hex codes listed there. However, you are likely to 
be able to see a slight difference in color in your printed 
book when using CMYK and Hex colors together.

Blues and teals are especially hard to match.

Our suggestion is to proceed with caution, perhaps 
avoiding placing colored objects from two different 
sources directly next to each other. Better yet, stick 
with one source consistently for certain colors. For 
example, make that teal headline in eDesign every time 
and use Canva for other colors in your palette.

For most people, the color variations may go unnoticed, 
but we wanted to provide this note so you would be 
informed. Please go to herff.ly/techsupport or talk to 
your rep for additional support in this area.



Welcome to the YBK fun. Have no fear. You’ve got this! 

W I T H  H E R F F  J O N E S ,  Y O U ’ L L  N E V E R  Y E A R B O O K  A L O N E .
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